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Audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and
use the audio interface and control surface functions of the R24 with a DAW and other

software.

Functions of the audio interface and control surface

[INPUT 1-8] jacks
Guitars and other
musical instruments,
built-in stereo mic #

[PHONES] jack
Playback device like
headphones or an
audio system

[OUTPUT] jacks
Stereo system,
speakers with built-in
amplifiers, etc.

USB Cable

Windows/Mac

DAW software

Cubase LE, etc.

Audio driver

B Audio interface

The R24 has numerous inputs and outputs
and it can be used as a Hi-Speed USB
(USB 2.0) audio interface with 8 inputs
and 2 outputs at quality up to 24-bit/96
kHz. Effects can be used when the sam-
pling rate is 44.1 kHz, and the unit can be
powered by a computer’s USB bus.

[l Control surface functions

On-board control surface functions can be
used to control DAW software on a com-
puter via USB. Transport operations, in-
cluding playback, recording and stopping,
and physical control of the DAW faders
are possible. Furthermore, various other
DAW software functions can be mapped
to the F1~F5 keys (assignable functions
depend on the DAW used).
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l Supports input from a variety of
sources, including guitars, mics and
line level instruments

The 8 onboard jacks accept XLR and
standard phone plugs and include one
high-impedance input and two inputs with
phantom power (24V or 48V).

Many sources are supported from high-
impedance guitars and basses to dynamic
and condenser microphones and line-
level devices like synthesizers. In addition,
built-in high- performance condenser
microphones are convenient for recording
acoustic guitars and vocals.

W Versatile effect functions

Built-in insert effects can be applied to
specific channel paths, and two-types
of send/return effects work via the mixer
send/return. These effects can be applied
when recording, of course, but they can
also be applied to only the monitor output.
For example, when recording vocals, you
can apply reverb only to the monitor sig-
nal to make singing easier.

[l Comprehensive built-in mixer

Using the R24’s mixer, you can make a
mix for monitoring. When simultaneously
recording guitar and vocals, for example,
you can adjust volume balance, panning
and reverb levels.

Moreover, you can also adjust the balance
between the built-in mixer and the sound
sent from a computer.

Il Multifunction tuner

In addition to standard chromatic tuning,
the on-board multifunction tuner also sup-
ports 7-string guitar, 5-string bass and
various drop tunings.




R24 Audio Interface system requirements

R24 Audio Interface system
requirements

Windows

Windows® 7 (32-bit, 64-bit) or later

32-bit: Intel® Pentium® 4 1.8 GHz or faster

64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster
32-bit: RAM 1 GB or faster

64-bit: RAM 2 GB or faster

Intel Mac

OS X 10.9 or later

Intel® Core Duo 1.83 GHz or faster
RAM 1 GB or faster

Both
USB 2.0 compatible port

e USB hubs are not supported.
o Intel® chipsets recommended.

Note about descriptions and images

This manual was prepared based on use with Win-
dows systems. Special functions related to Mac OS
X are indicated separately.

The screen images are of the Windows version.

About trademarks

Cubase LE installation guide

Please refer to the Cubase LE Startup Guide
for detailed instructions for installing the R16/
R24 audio driver and Cubase LE.

* The SD symbol s and SDHC symbol are trademarks.
+ Windows®, and Windows 7® are registered trademarks of Microsoft® in the USA.

+ Macintosh® and Mac OS® are trademarks of Apple Inc.

» Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH Inc.

« Intel® and Pentium® are trademarks of Intel Corporation.

* MACKIE Control is a registered trademark of LOUD Technologies.
« All other product names, registered trademarks, and company names mentioned in this documentation

are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
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Connecting and disconnecting in audio interface mode

This is an overview of connecting and disconnecting the R24 to a computer with a USB
cable. For details, see the included “Cubase LE Startup Guide”.

Connecting the R24to a computer R24 setup and connection
for the first time Follow these procedures when connecting again.
‘I Install the Cubase LE DAW ‘I USB  Press USB.
software on the computer.
2 Install the audio driver on the 2 Select i
computer from the included .
CD'ROM USB Change
AUDIO I-F 3 menu
Installation and setup details [ A
[II% Reference: “Cubase LE Startup Guide” } v
Connect the R24 to a computer.
4 P Press ENTER.
; A
( R24 setup and connection =
Setup the DAW software.
3 Select .
¢ Device setup ) AUDI0 INTERFACE [EEESINS
[l]%’ Reference: "Cubase LE Startup Guide" ] SETTING  [Continue mim
EXECUTE | F
(Control surface setup P7 ) v

Mackie Control

Press ENTER.

| NOTE

The ZOOM R16/R24 audio driver is essential for
using the R24 as an audio interface with DAW
software such as Cubase LE.
When downloading it, follow the included instal-
lation guide to install it correctly.

+ Download the latest R24 audio driver from the
Zoom Corporation website.
http://www.zoom.co.jp/



Connect the USB cable to the R24.

RE!
AUDI0 INTERFACE

Sanple Rate

Connect the USB cable to the
computer.

El H
Ja—
C — )

USB icon appears when connection completes.

[

Sanple Rate
96, 8kHz

( Disconnecting )

‘I Press the D below uss

2 Select

Terminate Change

menu

Are You Sure? A
A\

3 Disconnect the USB cable

| NOTE

Select CONTINUE to use the same settings as last time.
¢ INSERT EFFECT settings

* SEND RETURN EFFECT settings

* Mixer settings

* TUNER settings

Select RESET to restore default settings for each item.

+ The audio interface and control surface func-
tions of the R24 can be used by drawing power
through a USB cable from the USB bus.

+ We recommend always using the latest R24
system software.

+ When using phantom power, we recommend
using batteries or an AC adapter even when the
unit is used as an audio interface.

or [].
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Using control surface functions

When using the R24 connected by USB as an audio interface, the R24 keys and faders
can be used to control Cubase LE’s transport and mixer.

About the control surface

Control surface setup

In control surface mode the keys and knobs on
the R24 can be assigned to particular Cubase
LE functions.

[ Transport section P8 ]
[ About banks P9 ]
[ Fader section P9 ]
| HINT

Assigning keys

For a list of functions that can be assigned to the
knobs and keys of the R24, as well as other trans-
port/function keys that are supported by Cubase
LE, please consult the “Control surface functions
quick reference guide” in this manual.

Reference: Control surface functions quick
reference guide

P.12 }

{ See R24 setup and connection steps 1-5 on P5~6

6 Then, launch Cubase LE.

From the Cubase LE “Devices”
menu, select “Device setup...”

8 At the top left of the Device setup
window [+], [-] and [|<] buttons
appear. Click the [+] and select
“Mackie Control”

9 Set the MIDI input and output

MIDI input: ZOOM R16_R24
MIDI output: ZOOM R16_R24
| HINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.



Transport section

By setting up the control surface, the R24’s
transport section keys can be assigned to indi-
vidual functions in Cubase LE.

[F1]key [F2] key [F3]key [F4]key [F5] key

[_lﬂ m@ [_ij l_}wj mé@
| | B ]

CICCIG0C]

[REW] key [FFlkey  [STOPlkey [PLAY]key [REC]key
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Fader section operation

Using the faders and status keys of the fader section, you can adjust the volume of
corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

About banks

Operating the fader section

After setting up control surface operation, the
main parameters of Cubase LE can be oper-
ated using the R24’s fader and status keys.

A group of tracks operated by the faders and
status keys is called a “bank.” With the R24,
one bank of 8 adjacent tracks can be con-
trolled.

For example, if fader 1 is assigned to Cubase
LE track 1, tracks 1-8 can be controlled as
shown in the following diagram.

Control 1 2 3 4 5 6 7 8
Track | Tr1 Tr2 Tr3 Tr4 Tr5 Tr6 Tr.7 Tr8

As the diagram shows, when tracks 1~8 are
selected, pressing the [9~16tr (Bank>)] key
once switches the assignments as shown be-
low.

Control 1 2 3 4 5 6 7 8
Track | Tr9 Tr.10 Tr.11 Tr.12 Tr.13 Tr.14 Tr.15 Tr.16

1~8Tr

o[

1~8Tr (< BANK) key
Tracks (channels) assigned to the fader section are
moved backward by eight tracks.

9~16Tr

o[

9~16Tr (BANK >) key
Tracks (channels) assigned to the fader section are
moved forward by eight tracks.

‘I Assign the Cubase LE tracks
(channels) that you want to control
to the fader section.

2 Use the faders to control the

volumes of the corresponding
tracks.

The faders control the volumes of their re-
spective tracks. Change the master volume
by moving the [Master] Fader.

3 To change the function of the

status keys for all the tracks,
press the soft key for the desired
function.

AUDID INTERFACE
Sanple Rate

96, BkHz




R24 level meters

(Audio interface use)

179717
I
8/16/24

Each level meter other
than the MASTER displays
the signal immediately
before sending it to the

MASTER

The master level
meter displays the
returning signal from
the computer.

computer.

Checking DAW recording levels
” (in the
; ! (signal with
effect) or * (no effect) to send
signals to the computer with or without
being processed by the insert effects.
The recording levels of the sent signals are dis-
played on the level meters. The signal shown
on the master level meter differs from that
shown on each level meter.

] meny) to

% _I_ Red light Adijust the levels so that the
(clipping) red (0 dB) clipping indicators
q2— — on the meters do not light.

10
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1

Setting the function keys

The five keys above the transport keys can be used as function keys (F1~F5) and
assigned as desired.

Function key setup

2

3

Open the “Device setup...” dialog
in Cubase LE.

Select “Mackie Control”.

Commands can be assigned using the three
columns displayed on the right side of the
window.

From the “Button” column choose
the function key (F1~F5) to be
assigned a Cubase LE function.

Click on the “Category” column for
that control.

Choose the type of Cubase LE
function from the Category pop-up
menu.

Click on the “Command” column
and select the desired Cubase LE
function from the pop-up menu.

The items in this pop-up menu will differ
depending on the category chosen.

Press the “Apply” button.

J HINT

The display of MENU etc. may be different
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.




Control surface functions quick reference guide

12
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13

Using Cubase LE template files

Create a new project

‘I Copy the ZOOM R24 project templates
to the computer.

From the CubaseLE5_template folder on the CD
included with R24, copy the templates to the
location where Cubase LE is installed.

Windows

The folder opened by clicking Start>Steinberg
Cubase LE XX>User Settings Data Folder
Macintosh

/Applications/CubaseLE XX.app/Contents/
templates/

[ “XX” varies depening on the version installed.}

2 Launch Cubase LE and select File
> New Project.
Depending on your settings, either
the Steinberg Hub or the Project
Assistant dialog opens.

3 Create a new project

After copying the R24 project templates to
the designated folder, the R24 project tem-
plates will be displayed when creating a new
project. By choosing these templates you will
be able to easily create projects with audio
track input and output settings already ar-
ranged for the R24.

Template names and details

ZOOM R16_R24 8Mono Recording

Project with Cubase LE mono tracks 1~8
assigned to R24 INPUTS 1~8

ZOOM R16_R24 4Stereo Recording

Project with Cubase LE stereo tracks 1~4
assigned to R24 INPUTS 1/2 ~ 7/8

ZOOM R16_R24 4Mono 2Stereo Recording

Project with Cubase LE mono tracks 1~4
assigned to R24 INPUTS 1~4 and Cubase LE
stereo tracks 5~6 assigned to R24 INPUTS 5/6
and INPUTS 7/8

Tips to improve performance

When using Cubase LE, application perfor-
mance could become extremely delayed or
error messages such as “cannot synchronize
with USB audio interface” might be dis-
played. Should such occurrences become
frequent, the following measures might im-
prove the situation.

@ Terminate programs other
than Cubase LE that are

running.

In particular, confirm that many background
applications are not running.

® Reduce the use of plug-ins
(effects, virtual instruments)

If a large number of plug-ins are running, the
computer processing capacity might not be
able to keep up. In addition, reducing the
number of simultaneous playback tracks
might be effective.

© Use the R24 AC adapter

When devices draw power from the USB
bus, on rare occasions computer perfor-
mance can suffer. Try using the AC adapter.

If the sound breaks up, please increase the
Audio Buffer Size in the Device Setup...
menu > VST Audio System window.
Moreover, if the application performance
is extremely slow and regular computer
operation is affected, we recommend quit-
ting Cubase LE and disconnecting the R24
USB port from the computer once, and then
reconnecting the USB port and relaunching
Cubase LE.




The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R24’s internal
mixer. In addition, you can adjust the balance of the internal mixer and the sound from

the computer.

Volume, reverb send, pan

Stereo link

You can be adjust the reverb send, pan, vol-
ume and stereo link settings as in recorder

mode.
Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL)

PAN/EQ menu

VOLUME
Adjust the volumes of INPUTS 1~8.

Inputi

PR 16
REU SEMD I0FF

0~127 (increments of 1)
Default value: 100

LIOLUHE ]

=

REV SEND
Adjust the reverb send levels of INPUTS 1~8.

Inputl

Fl O 1E1E| 0~100 (increments of 1)
REV_SEND |L1 Default value: 0

DLUME Reverb only affects the
5T LIHE monitored signal (as in

recording mode).

PAN (BALANCE)

Adjust the pan for INPUTS 1~8.

L100~R100
(increments of 2)
Default value: Center
(as in recording mode)

Link even and odd numbered INPUTS to handle
them as stereo pairs.

Inputls2

]
ST LIMK [0

On/Off

Default setting: Off

By setting up a stereo link, volume, reverb send and
pan track parameters can be shared by pairs of even
and odd inputs simultaneously (as in recording mode).
(Reference: Operation Manual)

Balance knob

In audio interface mode, the balance of the in-
put monitoring signal and the signal from DAW
software (the computer) can be adjusted with
the BALANCE knob.

BALANCE
Left Right

Only the INPUT Only the DAW

1~8 signals stereo signal
MASTER CLICK

The reverb send, pan, volume and stereo link
settings are all saved when you terminate (& )
audio interface mode and can be used again the
next time.

[enuew aoeIalul olpny I
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Tuner

Bl The R24 tuner can be used as when recording. For details, see the Operation Manual.

|enuew 9oeLIS1UI OIpNY

Chromatic tuner I HINT
TOOL
The default value of the standard pitch is 440 Hz.
TOOL « Tuners other than the chromatic tuner can also
] D Press TOOL. be used.
Reference: Operation Manual )

2 Select

Change
menu I NOTE
A Tuner settings are saved when you terminate ( i
\ 4 audio interface mode and can be used again the
next time.

ENTER.

I Reference: Operation Manual

Tuner
To change the standard pitch, To change the tuner type, press
press the D beneath [[fRA. the D beneath ITHN.

CHROMATIC TUNER

Change the Change the
standard pitch tuner type
A



Effects in audio interface mode

The R24’s insert and send-return effects can both be used when the sampling
frequency is set to 44.1 kHz. Basic operation is the same but there are a few

differences in the menus.

Insert effect

Send return effect

As in recording mode, you can select the insert
location and the insert effect algorithm, as well
as the effect patches to be applied to the sig-
nal being recorded.

INSERT EFFECT menu

Select the insert location

As in recorder mode, use the
menu to change the patch and use the i+

menu to set the ! ! level that ad-
justs the reverb depth.

Setting the reverb send level

REVERB SEND

Insert on any INPUT 1~8.

INSERT EFFECT

IHSERT | REVERE

(Reference: Operation Manual )

Apply the effect only to monitoring

The effect can be set to only be applied to the monitoring
signal and to not affect signals recorded in DAW software.

INSERT EFFECT

REC SIG [t
THSERT [ REVERE

(Reference: Operation Manual )

t the amou
i level of the

Inputl
FEH Li8g
REW SEHD |A

OLUHE [
=T LIMK

(Reference: Operation Manual )
(Reference: Audio interface manual - Mixer)

| NOTE

+ Effects can only be used when the sampling rate
is 44.1 kHz. At all other times it is turned OFF.

+ Insert and send return effect settings are saved
when you terminate (£#17) audio interface
mode and can be used again the next time.

16
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Working with patches

After making many changes, you can restore a patch to its pre-edited settings by
initializing it. This will return it to its factory preset condition.

Patch operations
For both insert and send return effects

Patch operation menu

Selecting insert effect/reverb patches

Patch initialization (factory reset)
EFFECT .

To use an insert effect, select an algorithm and
a patch.

To use a send reverb effect, select a patch.
(Reference: Operation Manual)

Editing patches (EDIT)

By adjusting effect module parameters and
levels, you can create the desired result. (Refer-
ence: Operation Manual )

Importing patches (IMPORT)

All effect algorithms (and reverb patches) or
a single one can be imported from a selected
project on the R24.

(Reference: Operation Manual )

In audio interface mode, one complete set of effect
data is saved for the mode. There are no project
based settings.

Saving patches (SAVE)

Edited patches can be saved.
(Reference: Operation Manual )

Initializing patches (INITIAL)
Restores patches to their original factory set-
tings (only available in audio interface mode).

Changing patch names (RENAME)

The name of the currently selected patch can
be changed.

EFFECT
] D Press EFFECT.

Turning effects on/off

Insert effect

Press the D beneath Fik340.
Send return effect

Press the D beneath [HHIA.

The following example is of an insert
effect.

Turn the effect i
INSERT EFFEC

Select i &,
PATCH INITIAL Change
fre You Sure?
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Cubase LE Startup Guide

@ Install Cubase LE referring to the bundled @ Select "New Project" from the "File" menu.
' ' CUBASE LE
Download access code sheet'. @ DOWNLOAD INFORMATION

"Project Assistant" window opens in order to select a project template. Click "More",
select "Empty", and then click the "Create" button to display the project window.

Toguir of Cubase L5
Culbase LE dowslsad insluctions
— G

(- Cubase Elzments 7 - [Cubase Elments 7 Praject - Untitied 1 [
‘\' File Edit Project Audio MIDI Media Transport Devices Window Help Steinberg Hub & x

@ Download the latest driver from ZOOM website
(www.zoom.co.jp) and install it.

Connect the ZOOM unit to the computer. R
Please refer to Operation Manual how to connect. XXX XXX - XXHEX-XXHXK - XHXHK

(@ steinberg

Download access code sheet

@ Select "Add Track">"Audio" from "Project" menu and add new audio track.

Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio s Ty
system" in the Devices Column.

@ Select the downloaded driver or the devices including the ZOOM model names here.
e.g. H Series Multi Track is shown as following.

. MIDI Port Setup

CLICES OFF

QISR TRACK
Select "VST Connections" from "Devices" menu and set the input and output device L SN T
@ ports to the downloaded driver or the devices including the ZOOM model names. / l \
For multi-track supported models, click "Add Bus" and add the input bus.
e.g. H Series Multi Track is shown as following.

Stop button Play button Record button

Recording starts. Click "Stop" button to stop recording.

@ Click "Play" button to check the recording.

ZOOM H Series Multi Track ASIO
:|DOM H Series MultiT... IN L L . )
JOOM H Series Multi T... IN R This is all for the basic setting.
Sterea \| ZOOM H Series Multi Track ASIO For more information, pl refer to the Documentation from "Help" in Cubase LE or
O M T T visit Steinberg website (www.steinberg.net/en/home).
ZOOM H Series Multi T...

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.
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